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1. Introduction
Thank you for purchasing Fusion3’s F306 3D printer!

This manual is designed to familiarize you with your F306 and its use and give you the tools to get the most out of
your new printer. The F306 has been engineered for many years of trouble-free operation and outstanding output
quality.

Warnings
Your F306 contains parts that reach high temperatures during operation. Specifically, the print head and the print
bed get very hot. Do not to touch these components while the F306 is in operation or while they are at an elevated

AWARNING
Hot surface.
Contact may
cause burns.

Do not touch.

While we have carefully designed your F306 to operate in a safe manner, accidents can happen. Your F306 should

temperature (see Front View figure below).

NEVER be allowed to run unattended or overnight.

Your F306 contains components that operate at 110VAC. These components have been shielded to prevent
accidental access. The guards are marked with the warning below and shall NOT be removed while your machine
is in operation, or plugged into the wall.

/A\WARNING

Hazardous Voltage.
Potential shock hazard.
No user serviceable parts inside.

Cantact manutactures for service/ropair,

Your F306 also contains components that pose a pinch hazard while in operation, such as the linear motion
carriages and the extruder feed system. Take care to keep fingers, hair, other body parts, and clothing away from
these components while your F306 is in operation.

Pinch polnt
Can cause

severe
personal injury

Your F306 is a high-precision piece of equipment that is precisely constructed, aligned, and calibrated at our
factory. Refrain from subjecting your printer to shocks, drops, or heavy forces that may cause misalignment of the
components.



2. Common Tasks

Topic

How To

Reference

Glue Stick

Use only Elmer’s "purple disappearing" glue. If you are unable to find this,
Avery Disappearing Color Glue Stick is an acceptable alternative. Put down
thin, even Layers with no gaps between them. Apply one layer for PLA. Apply
two layers at right angles for ABS.

Section 4.3,
7.4

Cleaning the print bed

Use only water, your scraper and paper towels. Mist the entire bed until all
of the glue is uniformly purple. Use the scraper to "pile" the glue up making
it easier to wipe. After scraping the glue to one side, wipe it with the paper
towel. Then mist the bed again and wipe with another paper towel. Use
gentle pressure and never push down on the print bed with anything. Clean
the bed thoroughly after every print. ALWAYS apply fresh glue for each
print. After the printing cycle, the glue’s chemical properties change and it
loses some of its adhesive capabilities.

Section 7.4

Adjusting & leveling the
print bed

Make sure the print head is free of filament before you start the leveling
process. Do not scrape the filament off the print head. Heat the head and
wipe it gently with a clean paper towel folded over several times so you
don't burn your fingers (section 6.6). Never force the feeler gauge under the
print nozzle - you can damage the nozzle tip. Gently press down slightly on
the glass near where you are measuring the gap between the nozzle and the
bed, then release the glass and adjust the gap to the proper size.

Section 7.2

Moving the bed and print
head by hand

Always have the printer powered on when moving parts by hand, using
gentle and even motion to do so. To move the Z-axis, always use the belt. DO
NOT push on the bed to move it up and down.

Section 6.2

Loading & Unloading
filament

Follow the specified procedures for loading and unloading filament. Your
F396 has automated tools to simplify these procedures.

Section 7.3

Inexpensive and discount
filament

Use approved filament providers and keep filament in sealed bags with
desiccant when not in use. Be suspicious of inexpensive filament. The quality
of the base material, the quality and type of colorizing agents and whether
or not the filament has been protected from moisture all have a large impact
on how well it will print. Use of poor quality filament may void your
warranty — only use the filament suppliers listed on our website.

Section 6.3

Removing your print

PLA - remove with gentle twisting motion. Do not force. For stubborn parts
heat the bed to 70°C. Gently wedge scraper under a corner to lift the part.

Turn the bed heater off when part is removed.

ABS - self releases when the bed cools down to about 50°C. You will hear a
"pop" when they release.

Nylon - hold the scraper at a fairly "flat" angle and gently work it under the
part.

Section 7.6




Getting the 1st layer right The first layer is the most critical step when it comes to achieving consistent

high quality prints. See the pictures in this section. Section 8.2
Periodic maintenance Periodically, you should verify everything listed in Section 9. Section 9
!)ual prin't head Dual head printers are more complicated and some functions are different
information than described in the manual. Please read Appendix C. Appendix C

3. Your First Print

This section will guide you through the steps to get your F306 printing for the first time. We highly recommend
using the included roll of PLA filament, and printing the pre prepared file on your SD card. These instructions will
walk you through how to accomplish this.

3.1.Inspect Your System
If you had your F306 system shipped to you, see Appendix A - Unpacking & Setup for inspection instructions. If
anything has been damaged in shipping, it’s important to catch it now before it might damage something else!

3.2.Level the Print Bed
See section 7.2 for instructions on how to level the print bed. Out of the box, this is merely an inspection to verify
nothing has changed during shipment. There shouldn’t be any adjustments required. If there are any major
changes necessary, it could be an indication that the printer was jarred during transport from our facility to yours.

3.3.Load Filament & Prepare to Print
Every F306 comes with a free roll of high quality PLA. We highly recommend using this included material for your
first print. Not only is PLA an easy material to work with, but your SD card includes a pre prepared print file that is
configured to be printed using PLA.

Load the filament into your F306 using the “Load filament” script in the “Prepare” menu. See section 5.3 for more
information.

Next, prepare the print bed for printing.

Fill the included spray bottle with normal tap water. If the print surface is dirty, use the spray bottle and paper
towels to clean it. DO NOT use cleaners such as Windex, acetone, or rubbing alcohol to clean the print surface.
Using these chemicals can cause print adhesion problems. Use light hand pressure when cleaning the bed. You
should never push down on the print bed as that may misalign it. Always look at the bed corner clips after cleaning
the bed. It is possible that the clip can be wedged down among the threads of the bolt, preventing the bed from
sitting at its correct position (see figure). If this happens and is not caught, the first layer will be too far and
adjusting the corner clips without making sure the bed is properly seated in the corner clip to correct this will
cause future prints to be way too close, should the clip ever become “unstuck” from the threads. In this situation,
the bed would be so tight against the nozzle that the filament will not even come out and the extruder will begin
to chew into the filament, making an audible “click” every two seconds or so. If this happens, reset the printer,
lower the bed and manually feed filament to verify it is not an actual jam in the nozzle. Reverse the extruder by %
turn. Inspect bed once again.
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Figure 1: Print bed not correctly seated in corner clip

Once the print surface is clean and dry, apply the included purple gluestick. Hold the stick vertically and wipe back
and forth to apply a single, light, even layer of glue to the bed. Each pass should slightly overlap the previous pass,
preventing any gaps between passes. Since this is a small part we don’t need to coat the entire surface, just a
roughly 6 inch by 6 inch section in the center of the bed. See section 7.4 for more information.

A note on glue application: In addition to putting glue in the area the part will print, also put a 6 inch long glue
“stripe” where the nozzle “wipes” at the beginning of every print. This will help the plastic that is extruded before
the print starts to stick and not drag into the part area. Also note that PLA only needs a single thin layer of glue,
but ABS needs 2 thin layers put on at right angles to each other.

3.4.Print!
Now, we’re ready to print! Navigate to the “Card Menu” on the control panel and select the “getting started
prints” folder. You should see one file called “Twisted_Bottle_PLA.gcode” (the file name might be truncated.)
“Press” to select it, and your F306 will automatically begin the print!

First, your printer will move all three axes towards their minimum positions until it touches the limit switches. This
is called “homing the axes” and is how your F306 knows where it is in 3D space.

While it’s homing, it will begin heating the print bed to the correct temperature for PLA (45°C.) You should see the
temperature climbing on the control panel.

Once all three axes are homed, your F306 will finish heating the bed. Then it will begin heating the print head to
the correct temperature for PLA (205-215°C.) The print head will take 2-3 minutes to come up to temperature and
stabilize. It's normal for the temperature to oscillate around the set point 2-3 degrees before it begins to print.

Once both the head and bed are up to temperature, your F306 will begin the print by dropping the bed about
10mm. It will then pump out about 30mm of filament. This is to ensure the melt chamber in the print head is
completely filled with plastic before beginning the print. Then, the print head will move over and the table will rise
back to the 0 point. The print head will perform a rapid “wipe” move to the right, in order to wipe the purged
filament off of the head.

The print head will move to the center of the bed and begin to print your object! First, it will draw an outline
around the part called a “skirt.” This is a single extrusion bead offset from the part by about 5mm. The main
purpose of this is to stabilize the flow rate of plastic before beginning the actual part. It also allows you to make
sure the height of the first layer is correct, and that the material is laying down correctly.



After the skirt is complete, it will start printing the actual part. The first layer is always done at about 40% of
normal print speed, to ensure the material bonds to the print bed correctly. Your F306 builds parts by tracing an
outline around the perimeter of the part then filling the rest of the cross section with a zig-zag infill. The 3 top and
bottom layers are solid and the rest of the interior is a mostly hollow lattice (all of these settings are adjustable in
Simplify3D.)

After the first layer of both pieces is complete, your printer will speed up to the default printing speed of 100mm/s
for the rest of the part. The twisted bottle is a 2-piece print (body and top.) It should take about 30 minutes to
finish.

3.5.After the Print

After your F306 is finished building the part, the head will move to the back left corner, the extruder will reverse
6mm and the print bed will drop to the bottom of the machine. You may then remove the parts!

e  For PLA, you should be able to pop small parts off easily by hand. Large parts may need to heat the table
to 70°C in order to make them easier to release by sliding the included part scraper under the part. Hold it
at a slight angle and push it under the part. It’s easiest to start at a corner on the printed part.

e  For ABS, wait for the table to cool to ~50°C and the parts should self-release (sometimes accompanied by
a loud “pop.”)

You should be able to thread the top and body of the printed bottle together. The fit may be very tight at first, but
will loosen up as you thread it back and forth. Also, be sure the top doesn’t cross thread the first couple times you
assemble it.

Congratulations! You've finished your first print on your F306!

As a final step, remove the skirt and priming pile of filament from the print bed. Remove the used glues from the
bed using the spray bottle to wet it down with water. A paper towel or two will finish the cleanup. Again, it is
optional to scrape a single layer application of glue. It comes off fairly easily with single motion wipes with a paper
towel. ABS, however, needs to be scraped first. Remember, use only water to clean your print bed!

4. General Info—Software

4.1. Software toolchain overview
The job of the software toolchain is to convert a 3D model file into a list of commands that the F306 will follow to
build the object. The central piece of software in this process is called the slicer. We’ve selected Simplify3D
Creator because it combines excellent usability with a powerful, intelligent slicing engine. A 2-seat license to
Simplify is included with your F306. We do not provide technical support for other slicers.

The basic steps of the slicing and printing process are shown below:



Load .STL file

Design partin . .
enp into slicer,

CAD, export .5TL

Export .GCODE
file, transferto
printer

file configure print
settings

Figure 2: Slicing & Printing Workflow

4.2. Simplify3D Tutorials

Simplify 3D has provided tutorials to cover operation of their software:

http://www.simplify3d.com/support/tutorials/

When your printer was shipping, an email with license information for Simplify was sent from Fusion3 to the
contact person listed in the order for your printer. This email included a Simplify guide and described the process
for getting your license activated.

5.3.Setting up Simplify3D
Step 1: Set up your Account
With version 3+ of their software, Simplify introduced a new license management system that makes it easier to
see where your copies of Simplify are registered. You will need to create a user account and associate your license
key with your email and username.

There will be a link to set up your account in the email from Simplify. Please click on that link and follow the
instructions for setting up your account. Then, you will be able to access your Simplify3D Dashboard. You will find
“Downloads” in the left hand menu.

For additional information see this video.

Step 2: Download & Install
First, we recommend you uninstall any old versions of Simplify to avoid confusion.

Downloading and installing works the same: download the executable from your account page, and run it once it’s
finished downloading. The installation process is straightforward and remains the same.

Step 3: Copy Configuration Files to Hard Drive
You will also need to copy the configuration files (.FFF files) from your SD card to your hard drive. We recommend
creating a folder in your “My Documents” folder for them.

If you’ve downloaded them from our site, you’ll need to extract them from the zip file using software such as
WIinRAR or 7-zip, instead of copying them from the SD card.


http://www.simplify3d.com/support/tutorials/
https://www.youtube.com/watch?v=nzNTKMf4jcM
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Step 4: First Run & Setup

The first time you run the software, it will prompt you for your username and password. You will need to enter the
credentials you created in step 1. The software will “phone home” to assign a license key to your installation. You
will need to be connected to the internet for this first run. After this initial activation, the software may be run
without an active internet connection.

You’ll then see a setup wizard similar to previous versions of Simplify.

Introduction

This wizard will help configure the Simplify3D
Software for your 3D printer. You can return to this
wizard at any time by going to Help > Configuration
Assistant.

Please select your printer from the list below. If
your printer is not listed, please choose "Other”.

[Other

Simplify3D™
Integrated

Software
Solutions

On the introduction page, select “Other” in the drop-down as shown above.

IMPORTANT: Use the Simplify profiles provided by Fusion3. DO NOT use the F306 profiles built into Simplify!
Several customers have reported issues with these profiles not being set up correctly.



Click “Next.”

The next page does not matter, as any settings created here will be over-written when we import the F306
profiles. You can leave the defaults and click “Next”.

3D Printer Information

Please fill in the fields below based on your 3D printer specifications.
Printer name  Mew Printer

Machine type |Cartesian robot {rectangular build volume)

Firmware lRaepRap {Marlin/Repetier [Sprinter)
BaudRate | 115200

Build Volume 100.0

Nozzle diameter

Filament diameter

Number of extruders 1—:_3J
|| This printer has a heated bed

Click “Finish.”

Setup Complete

The Simplify3D Software is now configured for your
3D printer.

Happy Printing!

j Simplify3D"
Integrated

Software
Solutions

Simplify will now open.

10



The first thing we need to do is to import the configurations for your F306. Go to “File > Import FFF Profile”.

[, Al ok
Ty =N =it =Rgie=Tesply = Aot diny s Acepont= g
Mew.. CtrleM
Open Factory File... Ctri=0

Save Factory File... Ctri=5
Save Factory File As... Ctrl=Shift+5
Recent Factory Files ¥

Impert FFF profile
Export FFF profile

Import Madels Ctrl=1
Export Models k
Recent Models k

Preview G-Code File...

Exit

Processes (double-chidk to edit)
[Kiarna Toima |

In the dialog box that appears, navigate to the location on your hard drive where you extracted the configuration
files in step 3. Select all the profiles you wish to import and click “OK.”

Note: you may import multiple files at once.

You’ll get a popup saying import was successful.

- The foliowing profiles have been soccessfully mported and sre now avetsbds
Pegem the profile drop-clavwn list

F306_AES
F306_AESpra
F306_Allen 810

F306_Bridge
F306_DERAL S10-PLA
F306_DURAL_ABRS
Fa06_DUAE_ARS:HIRS

F306_DUAAL_PLA
Fi_HIPS
F306_Mylon-580
Fag6_PC
F34_PCTRE
Fa6_PLA
F306_TGlase
Fi06_Tritan

Note: Dual extrusion users will also need to repeat this process for the configurations in the “Dual Extrusion
Profiles” folder.

Next, we’ll need to remove the “new printer” preset from the list since it’s not set up correctly.

In the bottom left section of the application, click “Add.” A dialog box with various settings will appear.

11



Fle Edt View Mesh Reper  Tocls  Add-Iny  Account  Help

Models (doubsie <Ak % edt) [

B ILU--’.

155 Center and Arvange

Processes {doble-chck to edt)

3

ittt S e

" edtprocen setwrg

o Prepare 1o Pty

Process Name: :Processil

Select Profii: | New Printer * | |update Profie| [saveasNew | | Remove |
Auto-Configure for Material Auto-Configure for Print Quality

[Pa 7 [ Medium x)

General Settings

Infill Percentage: ['[ 0% || Indude Raft Generate Support

| Show Advanced | | SelectModels | [ ok || conca |

Click the drop-down menu next to “Select Profile.” You should see a profile titled “Default,” a profile titled “New
Printer” and all of the profiles you just imported.

12



|F306_ABSpro
F306_Aloy910
F306_Bridge
F306_DUAL_910PLA
F306_DUAL_ABS
F306_DUAL_ABSHIPS
e — F306 DUAL PLA

Select the “New Printer” profile and then click the “Remove” button to the right. A small window will pop up.
Make sure the “New Printer” profile is the only one selected (you can select multiple at once) and click “OK.”

Flease select the profiles you would like to remove.

New Printer
F306_ABS
F306_ABSpro
F206_Alloy310
F206_Bridge
F306_DUAL 910-PLA
F306_DUAL_ABS
F306_DUAL ABS-HIPS
F306_DUAL PLA
F306_HIPS
F306_Mylon-680
F306_PC

| SelectAl || selecthore | [ ok

Note: the “Default” process cannot be removed.
Now Simplify is set up correctly for your printer!

Additional Information About Simplify3D:
e Managing printer profiles: https://www.youtube.com/watch?v=eZ7HFPY1wog

e V3 FAQs: https://www.simplify3d.com/support/version-3-0-fags/

e V3 release notes: https://www.simplify3d.com/software/changelog/

e  Simplify Tutorials: https://www.simplify3d.com/support/tutorials/
Where Can I Get Models to Print?
If you don’t want to design your own parts, there are many sites on the Internet with freely available models

designed for 3D printing. Here’s a partial list:

e  http://www.thingiverse.com/

e  https://www.youmagine.com/

13


https://www.youtube.com/watch?v=eZ7HFPY1wog
https://www.simplify3d.com/support/version-3-0-faqs/
https://www.simplify3d.com/software/changelog/
https://www.simplify3d.com/support/tutorials/
http://www.thingiverse.com/
https://www.youmagine.com/

e  http://repables.com

e  https://cubehero.com/

6. General Info—Hardware

6.1. Machine Overview

Figure 3: Front View
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Figure 5: Axes Layout
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Figure 6: Control Board Detail

Cooling Fan
Filament

Feed Tube

Cooling Duct

Hotend Cooling
Fan & Duct

Heater Block [§5
Print Head Nozzle £

Figure 7: Print Head Detail
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Driven Gear A .
" Filament Feed Gear

(aka Hobbed Bolt)

Drive Gear

M

Figure 8: Extruder Cold End Detail (your extruder may look different than this-there are several versions in use on
the F306)

Figure 9: Control Panel

1. Print head current temperature
2. Print head set point (0 means the heater is off)
3. Heat bed current temperature and set point

17



Print head position in XYZ space

Feed rate (turning this knob will increase or decrease the print speed in real time
Indicates % complete while a print is running

Print elapsed time

© Nk

Message row

6.2. Precautions
Moving Components By Hand
If you need to move the print head, X crossbar, or Z axis by hand, only do this with your F306 powered ON, but
the stepper motors disabled (Prepare -> Disable Motors or simply press the reset switch.) Move components
gently and do not move them too quickly.

Particularly on the print head, do not use the cooling fan as a grab point. The proper method is to grasp the sides
of the carriage with your fingers as shown.

Figure 10: Print Head Recommended Grab Points

On the Z axis, use the toothed belt to move the platform up or down. DO NOT attempt to move the Z axis by
pushing or pulling on the platform directly. When moving the Z axis up, take care that you don’t move it too far
and collide with the print head. This can damage the print surface, the print head and cause misalignment.
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Figure 11: Moving the Z Axis by Hand

IMPORTANT: DO NOT move any part of the machine while it is powered completely off. When powered off the
motors will act as generators and cause electricity to be generated in the electronics, and this may damage the
control board.

Cleaning the Print Bed
Do not use cleaners such as glass cleaner, acetone or mineral spirits to clean the print bed. These will leave a
residue on the print bed and adversely impact print adhesion. Only use water to clean the print bed.

Lifting and Carrying

To move your F306, position the print head and crossbar at the rear of the machine (remember, move them slowly
by hand) and position the print bed at the bottom of its travel. Use the “Drop Table” file on your provided SD card.
Grasp the machine by the Y bars as shown and carefully lift the machine up. Take care not to catch the control
panel on you as you lift.

Optionally, you can remove the control panel from the printer for transport. This eliminates the chance of
inadvertent damage.

If you are going to be carrying your F306 through a doorway, we recommend folding the spool holder against the
frame. To do this, loosen the 2 bolts that hold the holder in the brackets, and fold it back. Re-tighten the bolts to
keep it in place.
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Figure 13: Proper Grab Points Detail
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Figure 14: Spool Holder Folded In

6.3.Filament

Quality Matters

Fusion3 has tested filament from multiple suppliers around the globe. The quality of the filament matters a
surprising amount. Even with an excellent 3D printer, poor quality filament results in poor quality parts. As a result
we’ve worked hard to locate and partner with top-tier suppliers.

Where to Buy?

Our belief is that people should be free to choose from a variety of sources when they buy their filament. For that
reason, we made the F306 compatible with a wide range of material types and spool shapes and sizes. You do not
have to buy filament from us!

You should purchase your filament from one of our approved suppliers. Suppliers on this list have been extensively
tested by us, and deliver high quality, consistent filament that works well in your F306. An up-to-date list of
approved suppliers can be found on our website at http://www.fusion3design.com/3d_printer_filament/ Use of

filament from other suppliers may void your warranty!

Material Compatibility

Thanks to its all-metal print head and high-temperature heated bed, your F306 is capable of printing nearly every
3D printer filament available on the market. There are nearly 100 materials currently available, and we simply
don’t have time to test them all and develop settings for them.

In order to successfully print a material, a .FFF configuration, often referred to as a profile, needs to be generated
for that material. This profile is loaded into Simplify and tells the software how to work with that material.

We include profiles for common materials (PLA, ABS, Nylon, etc.) with your F306.
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If there is a specific material you’d like to use, please email us at support@fusion3design.com. We may have a

profile we can share, or we’ll add that material to our “to be tested” list and generate a profile for it.

7. General Tasks

7.1. General Menu Information
The LCD screen attached to your F306 contains a set of menus that allow you to perform all of the functions
needed to run your printer. For instance, you may load and unload filament, home the axes, and set the
temperatures of the print head and bed.

Navigate through the menus using the scroll wheel. Turning the wheel left or right will scroll through the menu
entries, and pressing the scroll wheel in will select the highlighted entry. Spend some time scrolling through the
menu to familiarize yourself with how it works and where to find particular functions. Note that when you press
the scroll wheel on some items a sub-menu will appear to make the selections related to that item.

Menu Structure:
e  Prepare
o Disable Motors (de-powers stepper motors)
Home All Axes (homes machine to 0,0,0)
Home Z axis (homes only the z axis and leaves only Z motor energized — used for leveling the bed)
Load Filament (script for loading filament into extruder)

o O O O

Unload filament (script for unloading filament from extruder)
o Disable Heaters (turns off print head and bed heaters, if running)
e Control
o Temperature
=  Nozzle (sets nozzle temperature)
=  Bed (sets bed temperature)
=  Fan speed (controls speed of cooling fan, 255=max power)
= Other settings on this menu should be ignored
o Motion (should ignore this menu)
e Card Menu (shows list of all .gcode files and folders on SD card)
e  Tune (only shown during prints)
Speed (adjust speed of printer during print)
Nozzle (adjust nozzle temperature)
Bed (adjust bed temperature)

O O O O

Fan speed (adjust fan speed)
o Flow (adjust flow rate of plastic in real time)
e Pause Print (during print) (pauses print until resumed by user; heaters are left on)
e Stop Print (during print) (stops print, heaters are left on — run the “disable heaters” command next)

7.2. Leveling the Bed
Making sure there is a correct and consistent gap between the print head and the bed is known as “leveling the
print bed.” This is a very important step to get consistent high-quality prints and good bed adhesion. We’ve
designed the F306 to be easy to level and to hold this calibration well, so you should not have to perform this
procedure often.
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Video of leveling the print bed: https://www.youtube.com/watch?v=tQIVLfrwclE

First, make sure the tip of the print head is completely free of debris and plastic. If necessary, heat the print head
to ~200°C and gently wipe it clean with a dry paper towel. Allow it to cool to less than 50°C before continuing.
Never scrape the print head with a hard object!

Second, on the control panel navigate to “Prepare” > “Home Z axis.” This will home only the z axis and leave the
motor energized, holding “Z” in place while you perform the leveling procedure.

Manually move the print head to the front left corner. Position the tip of the nozzle as close to directly over the
spring as possible.

Use the 0.006” feeler gauge (provided in your toolkit) to check the gap between the print head and glass at the
front left corner. You want to feel very slight drag as you gently move the gauge under the nozzle. Be careful that
you are not lifting up on the feeler gauge when making this measurement because this can cause inaccurate
measurements. Never force the feeler gauge under the print head. If the gauge doesn’t fit, run the bolt in to
lower the bed, allowing the gauge enough clearance. Slowly back the bolt out until you feel the slight resistance.
The nozzle should not audibly pop against the glass as you slide the gauge out from under it. If this happens, it is
still too close.

Use the 2.5mm ball-end hex wrench to turn the bolts.

Figure 15: Leveling the Print Bed

If you lose your feeler gauge, let us know (support@fusion3design.com) and we’ll mail you another one.) If you

have misplaced your feeler gauge, a piece of paper folded over 1 or more times can work. Check the thickness with
calipers, if you have them, and adjust the number of folds until the total thickness is .006”-.007” (since paper can
compress under the nozzle). You may also need to try different weights of paper to get the right thickness.

23


https://www.youtube.com/watch?v=tQlVLfrwclE
mailto:support@fusion3design.com

With the front left corner adjusted, manually move the print head to the other 3 corners and adjust the height of
each corner. Then, check the front left corner again to ensure it’s still within spec. It is helpful to check each corner
multiple times, as moving one clip will change measurements across the bed. At each corner, make sure the nozzle
is directly over the spring or as close as you can get it to the spring. If you have to move the head to access the
corner bolt, make sure you move the head back to the same spot to re-check the gap.

When you’ve finished leveling the bed, navigate to “Prepare” > “Disable motors” to de-power the z axis motor.
The bed may drop slightly when the motor is turned off; this is normal.

As you gain experience with your F306, you may find that you need to tweak the gap to slightly larger or smaller
than described here to get optimal first layers, especially as you change materials.

Note: With the bed cold, it is normal for the center of the bed to have a smaller gap than the corners. Your F306
has been designed so that when the bed heater is on, this center gap will be the correct distance.

Important: The small pressure switch mounted to the upper rear rail is the end-stop trigger. Do not adjust this Z
endstop trigger. This is set at the factory to the correct distance from the bed and should not be adjusted by the
end user.

7.3. Loading & Unloading Filament Spools
Loading Filament
First, trim the end of the filament to remove any previously melted plastic, or any bends. It can help to trim the
end at an angle, as shown. This will help the end feed through the extruder system more easily.

Figure 16: Trim the End of the Filament

Install the filament spool onto the spool holder so that the filament pays off from the front of the spool. On the
extruder body, pull the springs down off of the idler bar. The bolts will pivot down. Lift the idler bar up so that you
can see the feed gear. Now is a good time to check for debris! If you see debris, use the provided toothbrush to
gently remove it.
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Figure 17: Extruder Ready for Loading Filament

NOTE: Some older machines do not have firmware equipped with the filament loading and unloading scripts.
These users should use the manual load procedure described below.

Automatic Loading: Navigate to the “prepare” menu and select the “load filament” option. The print head will
begin heating and you will see instructions on-screen to load the filament into the extruder.

Manual Loading: Navigate to the temperature control menu (Main -> Control -> Temperature) and set the nozzle
temperature to approximately 215°C.

Feed the end of the filament through the lower hole in the extruder body, across the feed gear, and into the exit
hole above the feed gear. Let the idler bar drop back into position once the filament is properly fed, and place the
clamp springs back onto the idler bar.
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Figure 18: Filament Fed Across Hobbed Gear
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Figure 19: Disengaging the Idler Bar Springs (top-original extruder, lower -current extruder)
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Figure 20: Engaging the Idler Bar Springs (top-original extruder, lower — current extruder)

Both: Slowly turn the large gear on the side of the extruder. Watch for the tip of the filament to come into view
inside the feed tube at the exit of the extruder. If you feel a sharp increase in resistance to turning the gear, STOP
and remove the filament. There may be debris in the tube or some part of the feed system has come out of
alignment. Once you see the filament just appear in the feed tube, proceed to the next step.

Automatic Loading: After the filament is fed about 1.5 inches into the tube, press the control knob to tell the
printer the filament is loaded. After the print head is up to temperature, your F306 will automatically feed the
filament through the tube and purge the print head. When that is done, the F306 will turn the heaters off, and you
are ready to print!

IMPORTANT: The automatic load script does not “know” where the filament is in the system. It's important not to
manually feed it any further than 1-1.5 inches into the tube. Otherwise it may attempt to feed the filament too
quickly into the print head and damage the system.

28



Manual Loading: While the print head is heating, turn the large gear on the side of the extruder by hand to feed
the filament through the tube to the print head. Once the tip of the filament enters the print head you will feel the
resistance to your turning increase. At this point stop and wait for the print head to come up to temperature.

Manual: Once the print head is up to temperature, slowly turn the gear to feed the filament into the melt
chamber. If you are switching materials, you will see the old material extrude and gradually transition to the new
material. Continue to run new material through until no traces of the old remain in the plastic.

Unloading Filament
Automatic: Navigate to the “prepare” menu and select the “unload filament” option. Your F306 will automatically
heat the print head and reverse the filament out of the extruder.

When the extruder stops turning, you can remove the springs from the idler bar and pull the filament completely
out of the extruder. There may be a “string” of plastic attached to the end of the filament, it is best to remove this
intact vs. breaking it off in the feed tube.

Manual: Grasp the large gear on the extruder and turn it backwards gently. Sometimes the filament will come out
of the print head without needing to heat it up. If it won’t come out, set the print head to about 200°C and wait for
it to heat up. Feed a couple of millimeters through the heated print head and then reverse it completely out of the
tube. Make sure you turn off the heater after you’ve unloaded the filament!

Secure the loose end of filament to the spool by routing it through the holes in the sidewalls or use a small piece of
tape. If you do not secure the loose end, it can unspool and tangle itself.

Lastly, check the feed gear for debris in the teeth. Debris in the teeth will make the gear more prone to slipping. If
you see debris, use the supplied toothbrush to clean it out.

Storing Unused Filament
Your filament is shipped in a sealed plastic package with a pack of moisture-absorbing desiccant. This is because all
types of filament will absorb moisture from the air if they are left out in the open for extended periods of time.

When you are not using a spool of filament, we strongly recommend you store it in a re-sealable plastic bag,
such as a Ziploc, with the desiccant pack it came with. This will keep moisture absorption to a minimum.

Leaving filament out for a couple days is not a problem. But you don’t want to leave a roll out in the open if you
aren’t going to use it for an entire week. Filament that has absorbed moisture will not print nearly as well as dry
filament.

Note: Nylon is more prone to moisture absorption than other types of plastic and should not be left in the open for
any length of time. Nylon’s printing performance degrades sharply with moisture absorption.

7.4. Cleaning and Prepping the Bed
Important: Only use water to clean the print bed! Cleaners like Windex, acetone, etc. will leave a residue on the
glass and adversely affect print adhesion.

Preparing the print bed for printing is very simple! Your F306 uses a water-soluble glue stick to coat the glass and
help objects stick. This has many advantages:

e |t works for every material we’ve tried.
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e |tis easytoapply.

e [tis easyto clean up since it is water soluble.
e Itis non-toxic and non-hazardous.

e It provides consistent adhesion.

Use only Elmer’s "purple disappearing" glue. If you are unable to find this, Avery Disappearing Color Glue Stick is
an acceptable alternative.

Prepping for a Print

With the bed less than 40°C and previous glue removed (see below), hold the glue stick perpendicular to the bed
and apply to the bed with parallel, slightly overlapping wipes. The goal is an even, light coating on the glass. For
PLA, a single layer of glue is sufficient. For ABS, 2 layers of glue laid down at 90° to each other are needed.

Figure 22: Bed Prepped for ABS

Miscellaneous Notes
e If you are printing a small part, you only need to coat the section of bed where the part will be printed.
e You want to apply the glue to a cold bed (<40°C) shortly before beginning a print. The longer the glue sits,
the less sticky it becomes.
o Applying the glue when the bed is hot will result in the glue stick melting as you apply it, and the glue goes
on too thick.
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Cleaning Off Glue from a Previous Print
With the bed less than 60°C, lightly spray the bed with water and let it sit for 10-20 seconds.

Use your included part scraper to scrape the majority of the glue to the rear of the glass in a front-to-back pattern.
Wipe this up with a paper towel.

With a clean section of your paper towel mist the bed and use single direction strokes to achieve clean glass.

It's not necessary to get the bed perfectly clean, but there should be no deposits of glue left.

7.5.Slicing and Printing a File

Refer to the Simplfy3D tutorials for detailed information on using the software.
Import the model into Simplify. Adjust scale, orientation and position as needed.
Add a process. Check the following in the process box that pops up:

e Material type
e Llayer height
e Infillamount

e  Support generation on/off
(Some of these may require you to click “show advanced.”)

Once everything is configured properly, click “prepare to print.” Simplify will process (slice) your part and present a
3D preview of the toolpath. This is helpful to check that everything is going to work correctly.

Once you’re happy with how everything looks, click “save toolpaths to disk” and select a location to save the
.gcode file. For large files, it seems to work better if you save it to your hard drive and then transfer the file to the
SD card vs. saving it directly to the SD card.

Next, eject the SD card from your computer and transfer it to the control panel of your F306.
Power up your F306 and prepare the bed for printing.

Navigate to the SD card menu (main menu -> card menu) and scroll through the list to find the file you just
prepared in Simplify. Press the scroll wheel to select the file. The rest is automatic! Your F306 will home and heat
the bed and print head to the correct temperature and the print will begin automatically, once the correct
temperatures are reached.

7.6. After a Print Completes
At the end of a print job, your F306 will automatically lower the build table to the lowest position and turn off the
heaters. It is normal for the small 30mm hotend cooling fan to continue to run (this fan runs continuously.)

Removing PLA Parts

For small- and medium-sized parts, you will probably be able to twist them loose by hand, or use your scraper to
pry them loose from the bed. If moderate force doesn’t work, don’t force it! Excessive force can cause
misalignment of the bed or Z axis.
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For large PLA parts or PLA parts that are particularly stubborn, manually heat the bed to 70°C and allow it to reach
temperature. This will soften the bottom layers of the part and allow you to wedge the part scraper under the part
and progressively separate the part from the bed. After the part separates, turn the bed heater off.

Removing ABS Parts
ABS parts will self-release from the bed when it cools below ~50°C. Attempting to pry them off the bed while the
bed is hot is not recommended: It's a good way to burn your hands and bend your parts.

Removing Nylon Parts

Wedge the part scraper under a corner of the part and slowly slide it under the part at a shallow angle. Too much
angle can cause the part to bend permanently. Nylon is fairly flexible so typically it is easy to get the scraper under
the part.

All Materials
After removing the part, remove the priming skirt that is printed around the part and the priming strip done at the
home position.

It is also good practice to inspect the print head tip for excess plastic that may continue to drip out as the print
head cools. If there is more than ~1mm of material on the head, it’s a good idea to remove it gently with your
fingers when the print head is cool.

Sometimes the nozzle will have debris stuck on it that cannot be removed when the nozzle is cold. In this case,
heat the nozzle to 220 degrees using the control panel and very carefully wipe it with a paper towel folded over
multiple times with a quick “pinching” motion. Be very careful you do not stay in contact with the nozzle for more
than an “instant” the nozzle is very hot when you are doing this operation. See the pictures below for more
guidance on this operation.

Figure 23: Using a paper towel to wipe debris from print head
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Figure 24: Using a paper towel to wipe the print head

- BE— |

Figure 25: Clean debris-free nozzle

8. Troubleshooting & Advanced Techniques

This section covers how to troubleshoot some common problems and some more advanced techniques.

8.1.Simplify3D Guidelines

While Simplify3D is easy to use, there are certain rules to keep in mind that will ensure you get the best results.

Part Orientation
The most important thing to keep in mind is the orientation of the part you are trying to print. The ideal situation is
an orientation that:

e Has the largest flat face of the part oriented against the build plate
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e Has little to no overhangs

The pictures below show the ideal and poor orientations for a particular part.

In the example shown above, we have satisfied our criteria for a large face to sit on the build plate. However, the
entire upper flange is unsupported and will not print properly without support structure.

In the orientation above we’ve reduced the amount of the part that is unsupported in free air. However we have a
small face in contact with the build plate.




This orientation is doing everything wrong. We have a very small amount of the part in contact with the build plate
and the entire part is an overhang!

This is the correct orientation for this part. We have a large flat face on the build plate, and overhangs are
minimized.

Figure 26: Correct and Incorrect Part Orientations

Checking Files Downloaded from the Internet

There are many sites online that have free models for you to download and these can be a great way to get
printing quickly. However, the quality of the models can vary widely. This section will cover the most common
issues and how to fix them.

Missing Faces, Inverted Faces, Non-Manifold, Etc

Simplify has some built-in utilities to detect common problems with .STL files. You can use these utilities by
selecting Repair > Identify Non-Manifold Edges.

File View Models Mesh |Repair | Tools Add-Ins Help

Models (double-dlick to edit) Identify Non-Manifold Edges
Clear Results

Torture_Test
Repair Normals

Repair Flipped Triangles
Flip Surface Orientation
Remove duplicate triangles
Remove orphaned triangles

| e ] | @ |

[ 155 Center and Arrange ]

Processes (double-dlick to edit)

Name Type ‘

Figure 27: Identify non-manifold edges

If the model has any issues, Simplify will alert you with the following dialog box. It will highlight the problem areas
on the model with red lines.
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Meon-manifold segments detected. Problemn areas have been identified on
rmodel.

Figure 28: Problems highlighted on the model

The easiest way to fix these errors is to use an automated cleanup tool such as Netfabb cloud (cloud.netfabb.com.)
This is a free service that will fix 99% of all STL issues without any user input needed. It does require a Microsoft
online account, however.

Model Does Not Sit Flat

Some models have a very slight tilt in one or more axes, and even though they appear to sit flat on the build plate,
they do not. This will cause issues with the part adhering to the print bed, since the first layer doesn’t cover the
whole bottom of the part.

o PN

(left) model appears to sit flat, but panning the view to the front shows a tilt (right)

36




Figure 29: Identifying and correcting parts not sitting flat on print bed

If we preview the toolpath, we quickly see there is a problem. Note that the skirt does not outline the whole
object, and the first layer is a tiny fraction of what it should be.

You can correct this by manually playing with the model’s rotation in Simplify until you get the first layer to cover
the whole object like it should. This can be a bit tedious, however.

Another option is to go to the Edit menu in Simplify Version 3.0 or later and select “Place Surface On Bed.” This will
give you a selection tool to select a single polygon on the part that you want against the bed. Select one of the
faces on the desired bottom of the part and the whole part will stick flat against the bed.

Model has Internal Geometry

Sometimes when inexperienced people make .STL files by combining multiple files into one, they end up with
internal geometry (faces inside the model). This can cause Simplify to become confused about what the outside of
the model actually looks like. Here’s an example of what that can look like.

Figure 30: Models built by combining two different CAD files can cause printing problems

Here we’re using Simplify’s cross section tool to look inside the .STL. What we see is that the creator of this file
most likely took an off-the-shelf model of a shoe, along with a model of a leg, and simply put them together. There
is a lot of internal geometry, like the toes on the foot and the fact that the shoe is hollow, that simply does not
need to be there.

Unfortunately there’s usually not a whole lot you can do about a model like this. Passing it through netfabb might
improve the situation, but it’s unlikely to completely fix it. Sometimes, these sorts of things print fine, even with
errors. Other times, they don’t. If you decide to give it a try, preview the toolpath carefully before printing!

Overhangs and Support

While it is ideal to minimize overhangs when you orient your parts for printing, Simplify3D has the capability to
automatically detect overhangs and generate a temporary scaffolding (commonly called “support structure”) to
provide a surface on which to print these features. After the print is complete, this scaffolding is broken away by
hand.
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Support structure can be turned on by checking the “generate support” check box in the process settings dialog
window. Support structure is on by default in most material settings.

g
‘ FFF Settings

Process Mame: Processl

Select Profile; |F306_ABS_210. fif *J[ mmport || Remove || Export |

General Settings

Infill Percentage: D 30% [ indude Raft |”] Generate Support

Show Advanced | [ Select Models ] I oK ‘ [ Cancel ]

Figure 31: Generate Support toggle

More advanced control of support generation options can be found on the “Support” tab in the Process Settings
dialog window by clicking “show advanced.”

Process Name: Process1

SelectProfle: |F305_ABS_210.fff ~) [ mport | [ Remove | [ Exort

General Settings

Infil Percentage: D 30% || Include Raft |¥] Generate Support

il | Support | Temperauwre | Cooing | GCode [ Swipts | other | Advanced |
Support Material Generation Automatic Flacement
|| Generate Support Material Only used if manual support is not defined

Support Fillar Resolution  3.00
Support Extruder |Primary Extruder = -

= Max Overhang Angle 50
Support Infil Percentage 30 £

Extra Inflation Distance 0.50 (= mm Support Infil Angles

Print Sparse Support Every 1 layer{s)

Seperation From Part
Herizontal Offset From Part 0.50

Upper Vertical Separation Layers 0

Lower Vertical Separation Layers 1

Figure 32: Advanced Support Options

When in doubt of the necessity of support, leave it on and let Simplify figure out where it’s needed. It may
sometimes generate support where it’s not actually needed, but that is the safer option.

More detail on Simplify’s support generation can be found on their tutorial page:
http://www.simplify3d.com/support/tutorials/adding-and-modifying-support-structures/
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Here’s an example of support in action. The following part, even when it’s oriented in the “correct” position, still
has an unsupported flange that will not be printable without support material.

Figure 33: Bracket

If we instruct Simplify to generate a preview of where it thinks support is needed, we see it generates the

following:

Figure 34: Bracket with Support

It’s important to note that if you left support turned off for this part, Simplify would not give you an error message
when you prepared the part for printing. It assumes you know when support is or is not needed.

Speed vs. Quality

The default slicing settings are set up for 100mm/s print speed and 0.2mm layers. We've found this is the best
compromise between print time and output quality. If you desire, you have full control over these parameters in
the Process Settings window.



A FFF Settings

Process Name: Processl

Select Profile: [F306_ABS_210.6FF v][ import | [ Remove |[ Export
General Settings
Infil Percentage: [} 30%  [[|IndudeRaft  [¢] Generate Support

Extruder | layer | Infil | Support | Temperatre | Cosing | GCode | Seripts | other | advanced

Layer Settings First Layer Settings

Primary Layer Height 0,2000

Primary Extruder First Layer Height 30

First Layer Speed 40

Top SOl taye

Raft Settings
Bottom Solid Layers 3 —
[ indudeRaft  RaftLayers |2
Outline /Perimeter Shells 2 e
RaftOffset {400 [=] mm

Qutline Direction; 7 Ingide-Cut @ Outside-In =
Separation !D. 10 < mm
[T Print islands sequentially without optimization e
Raft Infill 100 = %

[ single outline corkscrew printing mode (vase mode)
|__| Disable raft base layers

Start Points
Skirt Settings

) Use random start points for all perimeters =
5 [¥] tncude skirt/Brim ~ Skirt Layers 1
() Optimize start points for fastest printing speed

= Skirt Offset 75‘00
@ Choose start point dosest to spedific location " =

X000 5w 30000 5 mm SatOutines: | 1

o) o |

Figure 35: Layer Height is set on the Layer Tab

Process Namei Processl

Select Profile: |F306_ABS_210.FFF v ][ mmport | [ Remove || Export
General Settings

Infill Percentage: D 30% || IndudeRaft Generate Support

Extruder | Layer | mnfil | Support | Temperature | Cooing | GCode | Scrpts | Other | Advanced

Speeds Filament Properties

Default Printing Speed i Filament diameter 71.7000 7‘ i
Cutline Underspeed Filament price 456,00
Support Structure Underspeed 100

. Bridging
XJY Axis Movement Speed 21000.0

] ) Unsupported area threshold
Z Axis Movement Speed 10000.0 =+ mm/min

Bridging extrusion multiplier

Bridging speed multiplier

Figure 36: Print Speed is set on the Other tab

Layer Height Limits
Too tall of a layer height will result in poor intra-layer adhesion because they are not “squashed” together enough.
In general, you should not exceed 0.3mm tall layers.

Low layer heights have a different constraint. At or below 0.1mm layer heights, the ability of the extruded plastic
to bridge over small gaps becomes degraded due to the low flow rate. Depending on the geometry you’re making,
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this can range from not an issue at all to ruining the print. In general, we don’t recommend lower than 0.15mm
layers because the increase in surface finish quality is not worth the additional hassle.

If you have issues with the top solid layers not bridging the sparse infill, there are a few things to try:

e Increase the infill density
e Increase the number of perimeters (helps more for organic objects with shallow slopes)
e Drop the extrusion width to the size of the nozzle (default is nozzle size +0.05mm)

8.2.First Layer Height
This section will describe how to diagnose an improperly set first layer height. The bed leveling procedure
described earlier in this document has yielded very consistent, ideal results in our testing. That being said, it is not
foolproof. Symptoms of improper first layer height may include:

e The partis not sticking to the bed on the first 1-3 layers (first layer is too tall)
e  Obvious gaps between the extrusion beads are visible (first layer is too tall)
e  Excess plastic is piling up between the passes of the head (first layer is too close)

Below are images that show too tall, too close, and perfect first layer heights.

Figure 37: First Layer is Too Tall

The first image shows a first layer that is too tall (the print head is too far away from the print bed.) You can see
gaps between the traces of plastic that were laid down. You can also see that the infill is poorly bonded to the
outline of the object. The scrap of plastic on the outside is the priming loop that did not bond to the bed: further
evidence that that first layer is too tall.

To correct this, the bed and print head need to be closer to each other. The corner bolts need to be turned
counter-clockwise. Begin backing the bolts out little by little, attempting to move each corner the same amount.
The goal is to maintain the level and the entire bed be moved in the same direction, not one corner or side more
than the others. Make the necessary adjustments while monitoring the passes during this failed first layer. Once
the passes seem to be more ideal, reset the printer, manually retract 6mm of filament, manually lower the bed
and remove all extruded plastic. Restart the print and monitor the first layer. The main problem with too-tall a first
layer is that the part will not be bonded strongly to the bed, and can detach during the print job.
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Figure 38: First Layer is Too Close

This image shows a first layer that is too close. The infill traces are bonded to their neighbors, but we can see
excess plastic that accumulates above the infill traces. This is less of a problem than a first layer that’s too tall. But
in extreme cases, the print head and bed can be so close than no plastic is extruded at all. This can cause problems
with the extruder slipping or jamming.

To correct this, the corner bolts should be tightened (threaded in clockwise.)

Figure 39: First Layer is Correct

This last image shows a “perfect” first layer. The infill traces are firmly bonded to each other, but we see no excess
plastic building up between them. Of course, no excess is ideal, but you will most likely see some in different spots
of the print. When you can see the excess being pushed up across the entire print, that’s when it is too close.

This graphic from MatterHackers may also be helpful in understanding what the first layer does:
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Too much distance will cause the
Too High filament to extrude into the air.

This is wil not stick to the bed.

The tip of the nozzle is adding
slight pressure to the top of the
filament, greatly increasing how

Perfect much filament is securely
sticking to the bed and
subsequent layers.

The filament is not flowing

properly, which can cause ><
retrograde extrusion. Layers are

Too Low predominantly choppy and short.
Continued printing in this manner

will likely cause a jam.

8.3.Temperatures & Other Information
Printing temperatures for the most common materials:

PLA:

e  Print head: 200-220°C

e Bed:45°C

e Coat bed with 1 layer of glue.

e  For slow prints or prints with many successive retractions, reduce temperature to ~200°C.
e Increasing print speed will need a relatively large increase in temperature.

ABS:

e  Print head: 240-255°C (ABSpro 260-270°C)
e Bed: 100-110°C
e  Coat bed with 2 layers of glue at 90° to each other.
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Nylon-618:

e  Print head: 245-250°C
e  Bed: off
e Coat bed with 2 layers of glue at 90° to each other.

Taulman Bridge Nylon:

e  Print head: 245°C
e Bed: 70°C
e Coat bed with 2 layers of glue at 90° to each other.

Taulman T-Glase (PET):

e  Print head: 240°C
e Bed: 75°C
e Coat bed with a single layer of glue.

Miscellaneous Notes
e Lower temperatures may be needed for slower print speeds. The above temperatures have been tested
to work with the stock F306 print speeds.
o Higher temperatures will result in better layer-to-layer bonding and increased part strength.
e Higher speeds require higher temperatures to maintain layer-to-layer bond strength.

8.4. Part Warp (printing large parts)

Theory

Thermoplastics contract as they go from liquid to solid. This contracting causes the molten and cooling upper
layers to exert a pulling force on the lower layers, which have already solidified. If enough of this pulling force is
generated, you'll see the bottom corners of the part start to lift from the print bed. Larger parts, because they
contain more plastic, will have an increased tendency to warp. Certain shapes such as sharp corners are also more
prone to lifting from the bed. While we can’t eliminate this behavior, we can mitigate it with various techniques.

General Techniques
Decrease first layer height slightly by raising the bed.

Use “Brim.”

ABS
Print on bare glass with the same bed temperature. Use caution when using this technique as parts may adhere
strongly enough to damage the glass.

PLA
Print on bare glass. Set first layer temperature to 60°C, other layers to 51°C. As with ABS, this may result in very
strong part adhesion. Use caution when removing parts.

8.5. Printing Small Parts
Theory
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With small parts and short layer times, excess heat may build up in the part and prevent the plastic from solidifying
adequately before the next layer is laid down. This will result in poor output quality and, in extreme cases, may
result in failed prints.

While there are automatic cooling settings in Simplify that will control the cooling fan and print head speed, these
techniques can only do so much.

In Practice
The simplest method to make small parts print well is to print multiples of them, and space them out on the bed.

8.6. Print Head & Extruder Jams

Extruder system jams can have many causes. We’ll cover the most common and how to recover from them here.
You’ll usually see one or more of the following symptoms when there is a problem:

e  Material stops flowing out of the print head (usually happens first)
e The extruder motor skips, usually accompanied by a skipping, chirping, or grinding sound
e The extruder continues to turn, but the feed gear chews up the filament

If you experience an extruder or print head jam, you will need to halt the current print, as a jammed extruder
generally does not self-recover. Then you will need to diagnose why the jam occurred, and take corrective actions
to prevent it from occurring again. If you merely clear the jam without diagnosing the root cause, the jam will likely
occur again in short order.

Thermal Jams
Thermal jams primarily occur at the print head and, if not caught, can cause a slip or jam at the extruder. Some

common causal chains are below:
1. Print head temperature too low -> extrusion force is too high -> extruder slips or stops turning

a. Use correct print head temperature for the material
b. This can also be caused by using low quality material, particularly ABS.

2. Print head temperature too high -> heat conducts up filament -> filament swells and locks up in cold
section

a. Use correct print head temperature for the material
b. This can also be caused by using low quality material, particularly PLA.

3. (Most common) Filament retracted too far at end of print -> molten filament pulled into cold section ->
filament solidifies in shape of cold section -> filament cannot be fed forward or backward, and cannot be
melted

Generally occurs if print is manually aborted and user manually retracts filament too far.

b. To fix, stall the 30mm fan with something soft (like the tail of a zip tie). The fan will detect it’s
stalled and shut down to prevent burning up. Manually heat the print head up to 220°C and
allow it to sit at temperature for 10-20 minutes. The objective is to allow heat to soak into the
cold section; with the fan removed it will not be pulled away like normal operation. Ideally, this
heat will soften the jammed plastic enough that we can push it back down into the print head. To
attempt to feed the plastic forward, firmly hold the idler bar closed with your hand and slowly
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turn the large gear on the extruder in the feed forward direction. If it doesn’t clear after 3
attempts, please contact Support@fusion3design.com for assistance.

c. It may help to insulate the finned section by wrapping a paper towel or rag around the fins to
retain additional heat.

Mechanical Jams
Mechanical jams can occur at either the print head or the extruder. Some common causal chains are below:

1. First layer height is too low -> no filament extruded -> extruder slips or stalls
a. Correct the first layer height.

2. Extruder idler bar springs are too loose -> extruder does not grab filament -> extruder slips
a. Tighten the extruder idler springs.

3. Print requires many rapid retractions in quick succession -> filament near the feed gear heats up and
softens -> filament partially melts and flattens out from extruder idler pressure -> filament no longer
feeds through extruder -> extruder slips

a. Decrease the retraction speed (contact support for assistance.)

4. Thereis an imperfection in the filament diameter (usually a bulge) -> filament does not feed into extruder
-> extruder slips

a. Cut out the affected section of filament, inspect the remainder of the spool for additional
imperfections.

5. Debris on the surface of the filament, or in the filament (very rare) is fed into the print head -> the debris
is large enough to block the hole in the nozzle -> plastic stops extruding out the clogged nozzle -> the
extruder slips or stalls

a. Clear debris out of the print head.
b. Make a filament wipe out of a piece of paper towel and clothes pin to wipe off the outer surface
of the filament.

6. (V5 print head only) Strings and “hairs” of filament attached to the end of the filament can jam at the top
of the print head when the filament is re-loaded. This is because there is a chamfer at the top of print
head where the filament feeds into the print head.

a. This video covers how to remove the print head and clear the jam:
https://www.youtube.com/watch?v=68RRTFixMPo

b. To prevent this from happening, trim the tip of the filament clean every time. When unloading
the current roll, be careful to keep the strings and hairs attached to the tip — they like to break
off in the tube.
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8.7.Z Axis Noise

Your F306 Z axis is lubricated with a noise-damping lithium grease on the leadscrews and guide rods. In general,
you should not hear any noise from this system. Some degree of humming or buzzing during long movements is
not a cause for concern. If it annoys you, wiping off the existing grease and re-applying a lithium-based grease
should improve performance.

IMPORTANT: Do not use any other type of lubricant on the Z axis system (lead screws and guide rods.) Use of
other lubricants may void your warranty.

8.8.Experimental Materials
Your F306 comes with presets for the most common plastics such as ABS, PLA, Nylon blends, etc. However, it is
capable of printing nearly any thermoplastic that is available in filament form. Please contact
support@fusion3design.com for assistance in working with other materials. In general, we’re able to provide a
good starting point for further experimentation, if not a complete and tested material profile.

8.9.Different Print Heads

Over the course of production of the F306 Generation 1, we have used two different print heads. For
troubleshooting purposes, support may ask which print head your machine is equipped with. This is how to
identify which print head you have.

E3D V5 E3D V6

Figure 40: E3D Hot-end versions

e  Fan duct: V5 has black duct and V6 has translucent blue duct
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e Heater cartridge: V5 uses set screw to retain heater and V6 uses a clamping screw that bends the block
around the heater
e Thermistor: V5 has semi-clear leads on the sensor and V6 has blue or black braided leads on the sensor

9. Maintenance

9.1.Extruder Idler Bar Springs
In order to ensure the extruder maintains good grip on the filament, it’s important to periodically check the springs
that clamp the extruder idler bar in place.

Recommended service interval: once per month or every 40 hours of run time

Use the 2.5mm wrench in your toolkit to tighten the two bolts as far as they will go. They will stop turning when
the tips of the bolts make contact with the extruder motor.

A

~4 y
S
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Figures 42: Rev 1 idler bar (left) and rev 2 idler bar (right) and rev 3 idler bar (bottom)

e  For extruders with the idler bar that shows the idler bearing, reverse the bolts 1-1.5 turns.
e For extruders with the larger idler bar, reverse the bolts 2-2.5 turns.

e  For extruders with the “spring grabber” handles, set the gap between the washer on the bolt and the
plastic of the spring grabber to 0.43”. You MUST have filament in the extruder when you make this
measurement!

You should be able to slide the springs on and off the idler bar with your fingers with moderate force. If you can’t
disengage the springs by hand, try loosening the bolts an addition half turn.

49



Gap hetween washer and)face
Of Ih;/c tab set to 0.43”

Measure between washer
face and face of lift tab

Figure 43: Measuring spring gap for correct extruder spring tension.

9.2.Drive Cable Tension

The X and Y axes are driven by a pair of high-tensile-strength spectra lines. These lines are tensioned with
moveable idlers on the rear of the machine. Check for tension by gently “plucking” the cables in the center of the
rear span. The lines should be fairly tight, but not so tight they “hum” like a guitar string.

Recommended service interval: once per month, or every 40 hours of run time

Figure 44: Checking XY Drive Cable Tension
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If the cable tension is too low, first check that the idler brackets are in line with the extrusion; it’s possible one was
knocked out of alignment during shipping. To correct this, simply grasp the bracket and slowly pivot it back in line.

Figure 46: Re-aligning Idler Bracket

If the brackets are properly aligned but the cable tension is still too low, you can adjust the moveable idlers. To do
this, you will need a 4mm hex wrench and 10mm socket. Loosen the bolt on one of the idlers and slide it in the slot
to achieve proper tension. Then re-tighten the bolt.
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Figure 47: Adjusting the Idler Tension

If you adjust the cable tension, it’s a good idea to check the square of the X crossbar (see section below).

9.3. X Crossbar Square
The angle the X crossbar makes with the Y rails is determined by the relative cable tension in the two XY drive
cables. In order to get dimensionally accurate parts from your F306, the crosshar must make a 90° angle with the Y

rails.
Recommended service interval: once per month, or when the cable tension is adjusted

Measure the two diagonals shown with a tape measure. The exact measurement is not important, what is
important is that both measurements are the same. Butt one end of the tape measure into the corner made by the
X axis and the Y carriage plate. Make sure it’s seated in a repeatable manner. Measure to the middle bolt on the
front wrap brackets. Measurements should be within 1/16” of each other.
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Figure 48: Checking Frame Square

To adjust the square of the X crossbar, lightly pull on one of the drive cables at the rear to determine which cable
needs to be re-tensioned. When you have identified the correct cable to adjust, you will see the X crossbar square
improve when you add some tension by hand. Then, loosen the corresponding bolt and slide the idler pulley
forward or back to decrease/increase tension, respectively, until the X crossbar forms a 90 degree angle to the Y
axis.

9.4. Z Axis Rods and Leadscrews
The Z axis leadscrews and smooth rods on your F306 are lubricated at the factory with a long-life lithium-based
grease. This lubricant should provide thousands of hours of trouble-free use. The rods should not be lubricated
with any other lubricants! Doing so may void your warranty.

Recommended service interval: once per year, or every 2,000 hours of run time

9.5. Print Head

Regular Maintenance
Remove Plastic Debris

After every print, clear leftover plastic from the print head so it will not collide with it when it homes. Stubborn
plastic can be more easily removed by heating the print head to ~200°C and removing the now softened plastic.

The preferred method is to take a folded paper towel and use a pinching motion on the nozzle while sliding your
hand away from the nozzle.

Cleaning beyond this is more a matter of cosmetics than functionality.
Recommended service interval: after every print.

Check Heat Break Tightness
Periodically, it’s a good idea to make sure the heat break section is firmly threaded into the heat sink. It’s also a

good idea to check this if you move, adjust or otherwise touch the print head for other maintenance or service.
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Figure 49: Print Head Assembly

The hot section of the print head (right piece in the above image) consists of the aluminum heater block, a brass
nozzle and a stainless steel heat break. The top of the heat break threads into the heat sink portion of the print
head (left piece.) Do not disassemble the hot section of the print head: it has been carefully assembled at the
factory to prevent leaks.

The threads of the heat break are coated in a thermal transfer paste to aid in heat transfer from the stainless to
the aluminum. If you disassemble the print head, take care not to wipe off this thermal paste.

For proper performance, it’s important that the heat break be fully threaded into the heat sink. The easiest way to
ensure it’s fully seated is to leave the print head installed on the machine and grasp the heater block with your
thumb and forefinger (while it’s cool, of course.) Give it a firm but not excessive twist counterclockwise. It is
possible to over-torque the heat break and damage it. So, don’t apply lots of force.

From the factory, the print head is installed so that the faces of the heater block are square with respect to the
carriage and X and Y axes. If you haven’t removed the print head and you notice the heater block is no longer
square, it may have come loose.

Removal & Installation
This video shows how to completely remove and disconnect your print head. The video shows a V5 print head but
V6 is the same. https://www.youtube.com/watch?v=fplcCHhEf5w

9.6.Feed Gear

Every time you change spools of filament, check the teeth of the gear for debris and clean as necessary. Use a
toothbrush or firm bristle brush to completely remove all debris from the teeth.

10. Further Support

Please contact Support@Fusion3Design.com for further support. We like to start all support issues with email, and

escalate to phone or video chat if needed.
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11. Glossary

LCD Liquid Crystal Display
LED Light Emitting Diode
PSU Power Supply Unit
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APPENDIX A: Unpacking & Setup

This appendix is for our customers who had their F306 shipped to them.

Unpacking
Your F306 is shipped on a pallet inside a 3-piece box. This ensures your printer arrives undamaged and ready to

print. Remember to save your packing materials in case you need to return your F306 to us. The box folds flat for
easy storage.

Remove the banding straps or plastic wrap that holds the box onto the pallet.

Remove the lid of the box by lifting straight up.

Figure 50: Remove Box Lid

Around the top of the machine will be several white foam blocks that secure the printer in the box. Remove these
by gently turning them sideways to disengage them from the frame and lift them straight out.
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Figure 52: Removing Foam Blocks

Now you should be able to remove the sleeve from around the printer. Lift straight up, taking care not to hit the
F306 as you lift. The sleeve folds flat for easy storage.
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Figure 54: After Sleeve Removal

It’s time to remove your F306 from the pallet! Carefully grasp it in the middle of the Y rails and lift it straight up to
clear the foam blocks. Set it down on a firm, stable work surface. Refer to section 4.2 for lifting and carrying

instructions.

Remove the small box from the cardboard tray. This is attached with spray adhesive to keep it from bouncing
around during shipping. It should come loose with slight to moderate force. NOTE: There may be additional small
boxes, depending on how much filament you ordered with your 3D printer.
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Figure 55: Remove the small box

There is a spare print bed plate taped to the print bed with blue tape. Remove the tape and remove the spare
plate.

Remove the zip ties that hold the X axis and print head in place. They are marked with blue tape. There are two on
the left Y carriage and two on the X carriage.

Figure 56: Cut the zip ties flagged with blue tape (qty 4)

Open the small box and check the contents against the enclosed packing list.
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Checking for Damage

Before powering your F306 up for the first time, thoroughly inspect it for damage. This section will cover the major
things to look for, but keep an eye out for anything that looks abnormal anywhere on the machine. These sections
should be done in the order they are listed below.

If anything does not behave as described, please contact support to resolve the problem BEFORE powering up
your system.

Drive Cable Tension
Refer to Section 7.2.

XY Axes Motion

After you have checked the XY drive cables, you may very slowly move the X and Y axes through their full range of
motion by hand to check that everything moves smoothly. Gently grasp the top of the X carriage as shown in
section 4.2 and slowly move it through its entire range of motion in X and Y. You should feel little or no change in
resistance or binding as you move the carriage.

IMPORTANT: Since we are moving the axes while the machine is off, it is extremely important that this step be
done very slowly to avoid damaging the electronics!

X Crossbar Square
Refer to Section 7.3.

Check Print Bed
Check that the glass print surface is correctly captured under the corner clips and that the springs under the bed
are correctly seated. Make sure the gap between the glass and the substrate is roughly the same at each corner.

|

Figure 57: Bed corner clips should look like this

Power Up
Now we are ready to power up your F306 for the first time! Remove the power cord from its bag in the small box
and plug it into the socket next to the power supply on the left side of the machine. Connect the other end to a 3-
prong outlet.
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When you flip the power switch, these things should happen:

e Theinternal PSU fan should begin spinning quietly.

e The white LED lights should come on.

e The screen should light up, and after a moment text should appear.
e Agreen LED should illuminate on the control board.

e The print head cooling fan should begin running.

IF ANY ONE OF THESE THINGS DOES NOT HAPPEN, POWER DOWN IMMEDIATELY AND CONTACT SUPPORT
(support@fusion3design.com)

Check Z Axis
With your F306 powered up, we can now check the Z axis for proper movement.

Reach underneath the print bed and grasp the Z axis belt with your hand. Slowly move the belt in the direction that
lifts the bed up. Continue to move the belt by hand until the bed reaches the top of its travel. Be careful not to
collide with the print head!

Figure 58: Moving the Z Axis by Hand

While you are doing this, watch for these things:

e The resistance of the belt to your movement should be consistent. You should not feel more than a small
amount of “lumpiness” as the leadscrews rotate.

e  The Z axis should not bind or suddenly become hard to move at any point. More resistance at the bottom
of its range of travel is normal, with a gradual decrease as the bed moves up.

With the bed at the top of its travel, check the distance from the top of the adjacent beam to the steel plate near
each leadscrew. This is easiest to do with calipers, as shown in the picture, but can be done with an accurate ruler
such as a steel measuring scale. Do not measure this with a tape measure since the end of most tape measures can
introduce measurement error. The distance should be equal within 0.2 mm of each other (less than 0.1 inches.)
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Figure 59: Checking Bed Substrate Level

If the platform is out of level, please contact support for assistance. An out of level platform possibly indicates
rough treatment during shipping. We’ll want to guide you through some additional checks by phone.

If the platform is level, congratulations! Your F306 is now set up and ready to go. Make sure you follow the bed
leveling procedure (section 5.2) before attempting to print.
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APPENDIX B: High-Precision Flow Rate Calibration

Each F306 is precision-calibrated at our factory before it’s delivered to you. This calibration is generally accurate
within 5% with most spools of material. However, for those times where you need parts as close to perfect as
possible, the method described here will allow you to get the amount of extruded plastic perfect.

This method utilizes the included Filament Calibration Worksheet Excel file. There are basic instructions in that
worksheet, as shown below.

Section 1: Measure Filament Diameter Instructions
DIA (in) DIA{mm) AVERAGE 1. Measure & input the filament diameter in multiple places on the spoal.
0.0000 0.000 2. Input the average diameter into the slicer.
0.0000| 0.000 3. Slice and print a thin wall test object.
0.0000 0.000 0.000 4, Measure the wall thickness, input into sect. 2. The 2nd extrusion multiplier will be calculated automatically.
0.0000 0.000 5. Re-slice and print with new ext. mult. Measure wall thickness.
0.0000 0.000 6. Use linear regression on chart to generate subsequent ext. mult. as needed,
0.0000] 0.000 until measured wall thickness matches nominal wall thickness.
Section 2: Print Test Piece & Check Wall Thickness 1300
Nominal wall thick: 0.5
WALL THICKNESS MEASUREMENTS (in 1.000
TESTH# EXT. MULT. 1 2 3 4 AVERAGE (mm}
1 1.000 0.0000 0.0000| 0.0000 0.0000 0.000 0.800
Zr #DIV/0! 0.0000] 0.0000| 0.0000 0.0000 0.000
3 0.0000| 0.0000| 0.0000 0.0000 0.000 0.600
0.400
0.200
0.000 T T T T 1
0.000 0.200 0.400 0.600 0.800 1.000

Figure 60: Filament Calibration Worksheet

First, make a new tab in the worksheet and copy the template to the new sheet. This way the template stays the
same.

Step 1: Measure Filament Diameter

The first step is to measure the diameter of the filament as precisely as possible. The best technique is to take 3 or
more pairs of measurements, with each pair being at 90 degrees to each other at roughly the same place on the
spool, to capture any out-of-roundness in the filament. Take care not to crush the plastic with your calipers, as this
will affect your measurements. If you are new to calipers, online resources such as YouTube can be helpful. Take
measurements over as much of the spool as possible. You can use either metric or English calipers, and it will do
the conversion to metric for you.
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Figure 61: Measuring Filament Diameter

The spreadsheet will then calculate an average diameter, which you input into Simplify as shown below.

Process Mame: Process1

Select Profie: [F305_PLA_210.ffF ~J[ mport || memove || Export |
General Settings

Infill Percentage: D 30% || Indude Raft [] Generate Support

Extruder I Layer I Infil | Support | Temperature I Cooling I G-Code I Smm{WMvaﬂced

Speeds Filament Properties

Default Printing Speed
Qutline Underspeed 100

Suppert Structure Underspeed 100
Bridging
XY Axis Movement Speed 21000.0

i i Unsupported area threshold  50.0
Z Axis Movement Speed 10000.0 |5

Bridging extrusion multiplier

Bridging speed multiplier

Hide Advanced | [ select Models |

Figure 62: Input Filament Diameter

Step 2: Prepare test object

Next, set up Simplify to slice a simple object with the following settings:

e 1 bottom layer
e 0Otop layers
e Oinfill
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e 1 perimeter

o Make sure the “extrusion width” in Simplify matches that in the spreadsheet. It should be equal to or 0.05

larger than the nozzle size (currently 0.4mm.)
e Weinclude a 40mm box that works well for this test.

Slice, save and transfer the file to your printer. Load the spool of material and run the part.

Step 3: Measure wall thickness

Now use the second half of the spreadsheet to measure the thickness of each of the 4 walls. The spreadsheet will
calculate your average wall thickness and automatically compare it to the “nominal wall thickness,” a.k.a. what

Simplify thinks the wall thickness is.

It is extremely important to use good measurement technique when measuring the wall thickness, as bad
measurements will result in poor calibration. You want to grab only the top 3-6 layers in the jaws of the calipers,

and use very light pressure so as not to crush the wall.

Once you input your 4 measurements, the spreadsheet will automatically calculate a corrected extrusion multiplier
on the next line. Simply input this number into the process settings panel and re-slice and re-print the test part.

T <
&8 FFF Settings (2] = |
Process Name: Process1
Select Profile:  |F306_PLA_Z10.fff '| l Import | [ Remoye l [ Export ]
General Settings
Infill Percentage: * D 30% [7] tnclude Raft [ Generate Support

Extruder “| Layer I Infill I Support I Temperature | Cooling I G-Code I Scripts I Other I Advanced

Extruder List
{click item to edit settings)

Primary Extruder Toolhead

Overview

Extruder Toolhead Index |Tool 0 =

Primary Extruder

Extrusion Multiplier 1,00

Extrusion width () Auto @ Manual 0,45 |5 mm

Ooze Control
[¥] Retraction Retraction Distance 6,00 2 mm
ExtraRestartDistance 0.05 | mm
Retraction Vertical Lift 0,00 = mm
Retraction Speed 24000.0 |5 mm/min
@ [ Coast at End Coasting Distance 0.50 || mm
M] [T wipe Nozzle  Wipe Distance 5.00 = mm
[ Hide Advanced I [ Select Models | [

Figure 63: Input Extrusion Multiplier

Once you have printed and measured 2 test objects, you can set up the linear regression on the chart to more
accurately estimate your correct extrusion multiplier. You'll need to edit the plot data and select the correct tab in
the spreadsheet. Excel seems to break the data links when you copy the template to a new tab. Then, your third

extrusion multiplier is given by the regression equation displayed on the chart.
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In general, you should be able to get within 1% of the correct flow rate with 3 trials.
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APPENDIX C: Notes for Dual Extrusion Owners

This section outlines changes in the hardware, software and operation of your F306 if it is outfitted with a second
print head. While dual extrusion does provide additional powerful capabilities, it is not as easy to use as single
head machines.

Hardware Changes
Dual head systems consist of a second extruder unit mounted beside the first, as well as a slightly different print
head design that carries 2 print heads and allows for the alignment of the heads. The additional extruder behaves

exactly the same as the first. The print head assembly consists of 2 E3D V6 print heads, 2 blowers, and the print
head bracket.

The primary extruder is called EO, and the secondary extruder is called E1. EO is the left extruder and left print
head.

Figure 64: Dual Print Head

NOTE: The print heads have been precision-aligned at our factory. It is EXTREMELY IMPORTANT that you avoid
bumping, pushing, or otherwise causing the print heads to become misaligned. If the print heads come out of
alignment your dual-head prints will have an offset. Do not loosen or tighten the clamp bolts shown in the image
below, as doing say may cause the print heads to become misaligned. Note that later versions of the F306 Dual
look slightly different than this.
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Figure 65: Print Head Clamp Bolts (blower removed for clarity)

The two centrifugal blowers are wired together, so both will operate at the same time.

Due to the layout of the print heads, it's normal to lose 20-25mm of travel in the Y direction. Your system’s
firmware has been updated to account for this shorter travel.

Your spool holder has been replaced with a longer one that can hold two spools side-by-side.

Software Changes

Firmware

Due to firmware differences compared to our single-head systems, your dual-extruder system does not have the
“load filament” and “unload filament” options in the “Prepare” menu. Instead, we’ve prepared load and unload
gcode scripts that reside on your SD card. There are 4 scripts in total: a load script for each print head, and an
unload script for each print head. These work similarly to the scripts for the single head systems.

Simplify3D
Depending on what your goal is, there are a variety of ways to set up Simplify with your dual head F306. The most
common uses are:

1. Object printed in material A, support material printed in material B. This is the most common use, and
allows for the printing of highly complex models where using a single material for the part and the
support structure is not practical.

2. A 2-color object, using the same material in different colors in each print head. This can look really cool,
but requires a 2-piece model specifically designed for 2 color printing.

3. An object made out of 2 materials with different properties. For instance, this could allow a simulated
overmold using a rubber-like material. This is not very common.

What we’ve done is provided Simplify configurations for cases 1 and 2. Now, because there are a very large
number of combinations of possible materials and ways to set up Simplify, we didn’t make a configuration for each
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case. That being said, you should be able to build custom profiles as needed using the information in here and in
the configurations.

Printing with Separate Support Material (option 1)
The profile for this setup is called “F306_DUAL_ABS-HIPS.fff.” This is set up to build the part out of ABS and the
support structure out of HIPS. HIPS is soluble in limonene so it can be used as soluble support.

For example, let’s say you wanted to set up Bridge+HIPS. You’d need to copy this profile (and probably rename it)
then examine the print settings for Bridge in the F306_Bridge.fff profile and copy the temperature and retraction
settings over to the dual head profile.

If you want to do this same thing with PLA as the model material, you may need to find another support material.
Since both materials will be printed at the same time, the glass transition temperatures of the materials need to be
similar.

Printing in Multicolor (option 2)

There are two profiles needed for this setup. They are F306_PLA_DUAL_Multicolor_0.fff and
F306_PLA_DUAL_Multicolor_1.fff. Simplify has a pretty good tutorial here:
http://www.simplify3d.com/support/tutorials/printing-with-multiple-extruders/ You’ll need to scroll down to

“workflow for 2 colors.”

Basically, you have 2 .STLs; one for each color. You add 2 printing processes in Simplify; assign the _0 profile to
process 1 and the _1 profile to process 2. In process 1, you make sure only one .STL is selected. In process 2 you
select the other .STL. When you click “prepare to print,” select “continuous printing” in the dialog box that pops

up.

It can be a little hard to tell what’s going on in the toolpath preview. Ultimately, the best way to know if you have
it set up correctly is to try printing.

If you wanted to do multicolor in another material, you’d copy these two profiles and put in the correct
temperature, retraction, etc. settings.

Operational Changes

First, we strongly recommend you use your F306 as a single head printer for your first prints. This will allow you to
become familiar with the system before adding the additional complexity of a second print head. The standard
single-head Simplify profiles are fully compatible with your system. The second print head will merely not be used.

Loading Filament

Filament is loaded into the extruders normally. The spool for the left extruder (EO) should be mounted on the spool
holder first, closest to the frame. The spool for E1 should be mounted towards the outside of the spool holder. This
way, there is no crossover of the filament leading into the extruders.

Miscellaneous

Starting wipes need to be monitored more closely. With 2 heads there is a greater chance they will catch debris
when starting the print. Also the starting wipe on a dual extrusion machine is going to be slightly farther back in Y
since the Y endstop switch is mounted farther back.
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